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IMPORTANT NOTES: 
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Handbook. This Handbook only includes basic information on the tasks needed to automate a team/meet. 
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 Screen shots used in this Handbook are from earlier versions of Meet Manager/Team Manager and 
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 While care was taken to provide 100% accurate information in this handbook, there is likely to be a mistake 
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apologies and forward the information to rjfox@verizon.net. Thank you for your understanding. 

 

Contents 
Chapter 1 2 

1-1. Before Starting the Season .................................................................................................................................... 2 

1-2. Understanding Team Manager and Meet Manager ........................................................................................... 2 

Chapter 2. Using Team Manager ..................................................................... 3 
2-1. CCSDA Team Abbreviation Codes .......................................................................................................................... 3 

2-2. Set-Up 2011 Database ............................................................................................................................................... 3 

2-3. Load 2011 CCSDA Meet Event File ........................................................................................................................ 5 

Chapter 3. Meet Entries .............................................................................. 6 
3-1. Prepare Meet Entries with Team Manager ......................................................................................................... 6 

3-2. Print Entry Paperwork (Visiting Team) ................................................................................................................. 8 

3-3. Export Entries and Athletes ................................................................................................................................... 9 

3-4. Exchange Entries ........................................................................................................................................................ 9 

3-5. Setting Up Meet with Meet Manager ................................................................................................................. 10 

3-6. Running a Home Meet................................................................................................................................................ 11 

3-7. Wrapping Up the Meet ........................................................................................................................................... 20 

3-8. Get Ready for Next Meet ..................................................................................................................................... 23 

3-9. Records ....................................................................................................................................................................... 24 

http://pvswim.org/official/training/Hy-
http://www.countryclubswimanddive.org/
mailto:rjfox@verizon.net


Automating Meets 2011 CCSDA Automation Handbook 
 

 

CHAPTER 1 

1-1. Before Starting the Season 
Make sure that Team Manager and Meet Manager are installed on the computer you’ll be using. Most 

recent versions are Team Manager 6.0 and Meet Manager 3.0. 

If automatic updates don’t occur when you log on to software for the first time this year, be sure to 

download Maintenance Updates for each program from the Hy-tek website (hy-tekltd.com). Note that 

only the most recent versions of Team Manager and Meet Manager are supported by Hy-tek. 

Check all equipment prior to first meet to make sure everything’s working properly and make sure you have 

all supplies on hand. 
 

Computer and Accessories Printer Supplies 

 Computer 

 Power Cord 

 Mouse 

 Keyboard or Number Keypad 

 Power Strip 

 USB Hub or other adapter(s) 

 Heavy Duty Extension Cord 

 Flash drive with Roster & Meet Entry files 

 Extra flash drives 

 Printer(s) 

 Power Cord(s) 

 Cable(s) 

 Printer Paper 

 Labels (Avery 5160 or 
equivalent with 30 
labels/page) 

 Extra Printer Cartridges 

 Stapler 

 Scissors 

 Scotch Tape 

 Pens & Pencils 

 Box, Container, or 
Envelope for printed 
results 

 

1-1.a1  Computer 

Set up the computer together with printer(s), mice, and keyboards before your first meet and test to make sure 
everything works together (printer drivers are installed, etc.). 

 Since most new laptop computers do not have floppy drives you will need a flash drive or a CD to import and 
export meet files. 

 Mouse and keypad often make it easier. 

1-1.a2  Printer Issues 

 Check the connections of your laptop to make sure you have enough compatible ports to use for the mouse, 
keyboard and printer. 

 Drivers must be installed for each printer that you will use. Most drivers and installation instructions can be 
downloaded from manufacturers’ websites. 

 

1-2. Understanding Team Manager and Meet Manager 
Hy-Tek’s Team Manager and Meet Manager are both necessary for team operations. You will have one Team 
Manager database for the 2010 season that will hold all athlete information and the results of each meet. You will 
have a Meet Manager database for each meet of the season. Information is moved between Team Manager and 
Meet Manager by a process of exporting and importing as shown below. 

 

 
Use Team Manager to: 

 Maintain team & athlete roster data, 

 Create entries for each meet, 

 Maintain times for your team’s athletes, 

 Print top times report 
 

Use Meet Manager to: 

 Import rosters and entries from all teams competing in a meet. 

 Print meet programs & lane timer sheets 

 Run the meet & enter times, 

 Print award labels 
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1-3. Using Team Manager 
1-3.a1  CCSDA Team Abbreviation Codes 

Please use the abbreviations below for the team codes needed to set up your database.  (See section 2-2a6.) 
 

Argyle – AG 
Army-Navy – AN 
Avenel -- AV 
Belle Haven – BH 
Bethesda – BE 
Chevy Chase – CH 
Columbia – CO 
Congressional – CG 
Edgemoor – ED 
Kenwood – KE 
Lakewood – LA 
Manor – MA 
Montgomery – MO 
Norbeck – NO 
Washington Golf – WG 

 

1-3.a2  Set-Up 2011 Database 
You can use the 2010 database to create a Team Manager file for 2011(if using Team Manager for first time, 
skip to Step 2-2a3) 

1-3.a3  Open 2010 Database 

 FileOpenNew. 
Highlight 2010 Team Manager database. 

 File Name OR Open 
You’ll be taken back to Main Menu. The path to and name of the database that you just opened will be displayed at 
the top of the screen. 

 

1-3.a4  Back-up 2010 Database 

 File Backup. 

 Browse to the drive and folder where you want to store the backup. 

 OK. 

Yes to confirm. 

 OK when you see “Backup Completed Successfully…” to return to Main Menu. 

Tip You can set default directories for imports, exports, and back-ups from the Main Menu. 

Set-up Preferences Directory Preferences to reach the “Favorite Directories” screen. 

1-3.a5  Create 2011 Database 

File Open/New from Main Menu.  Name the 2011 database. 

Open. 

The new database will appear in the top bar and the “System Preferences” menu will appear. 

Cancel and ignore the pop-up message. 
 

 

In the next step, you will restore your 2010 database into the 2011 database you just created. If this is your first 
database, skip to Step 2-4. 

 

1-3.a6  Load 2010 Data to Create 2011 Season Start 

 FileRestore from the Main Menu. 

Highlight the 2010 backup file you created in 1-3b. 

on the file  OR Open 
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 “Replace currently opened database” in the “Restore” screen. 
 OK. 

 OK to confirm that you want to replace the new file with the 2010 database. 

 OK to acknowledge that the restore is complete. 

 
When the restore is completed the information from your 2010 database will be in the 2011 database. 

Now you will do edits and deletions to make the database ready to use for the 2011 season or enter new information 
if creating a 2010 database from scratch. 

 

1-3.a7  Check System Preferences 
 

FileSet-upPreferencesSystem 
Preferences. 

Check “Team/Swimmer Defaults.” Change as 
shown on the right if necessary. 

Change “Meet Age-up Date“ to June 1 of current 
year (June 1, 2011) 

Change “System Age-Up Date” to June 1 of 
current year (June 1, 2011). 

Yes when this box appears. 
 

 

OK to close System Preferences. 

  in top-right corner to return to the Main 

Menu. 

 

 
1-3.a8  Check Team Information 

Teams from the Main Menu OR  to highlight Team Name. 

Check that Team Code and Name match abbreviation and name assigned by CCSDA (code list in Section 2-1). 

OK to close Team Maintenance, then  to return to the Main Menu. 

 
1-3.a9  Delete 19-Year Olds/Swimmers Who Have Moved, etc. 

 

 “Athletes” from the Main 
Menu. 

 “Age” column to sort by 
age. One click places the 
19-year olds at the bottom 
of the list. A second click 
sends them to the top. 

Highlight  Athlete to be deleted. 

 “X” located left of the little 

stopwatch. 

 “Yes” or “No.” 

You can delete only one athlete 
at a time. 

  to return to the Main 

Menu. 
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1-3.a10 Mark Non-Returning Athletes as inactive 

If there’s a chance swimmers will return to your team next season, you can mark them inactive rather than deleting 
their information entirely. To do this, Click Athletes →Choose the Athlete you wish to mark inactive→in bottom right, 
check the “inactive” box. To re-add this athlete at a later date, simply uncheck the inactive box. 

 

1-3.a11 Add Athletes to Team Database 

While in your team’s 2011 database, Click on “Athletes” →”Add” →and enter the requested information. Be sure to 
focus on the following: 

 Swimmers’ names spelled correctly 

 Birthdates 

 Gender 

This information is required for each athlete. You may enter other information to build a team directory if you would 
like, but it is not necessary to complete team entries, etc. 

 

1-3.a12 Delete 2010 Meets 
 

 “Meets” from the Main Menu. 

Highlight Meet to be deleted; Clinic 
3 in this example. 

 “X” located to the right of the 

. 

 “Yes” or “No.” 

You can delete only one meet at a 
time. 

  to return to the Main Menu. 

 

 

 

1-4. Load 2011 CCSDA Meet Event File 
You can use a meet entry file from last year, or download a Meet Entry File Template from the Automation page of 
the CCSDA website.  If using the Entry File Template: 

 

1-4.a1  Import Files to Team Manager 

 File Import Meet Events from the Main Menu. 

Browse to location where you stored these files. 

 the meet you want to import plus Open, OR on the file name. 

 OK 

Highlight the file in the “Import Events” screen 

 OKOpen OR on the file name.  It will have an .ev3 extension. 

 OK in the bottom-right corner of the “Import Events” box. 

 OK when you see the box displayed below. 
 

 

You will need to either copy a previous meet or import and rename a copy of the Entry template for each meet your 
team will participate in this season. 
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MEET ENTRIES 

1-5. Prepare Meet Entries with Team Manager 
1-5.a1  Individual Swimmer Entries 

 

 Meets from the Main Menu 

Highlight The meet on which you 

want to work.  In this 
example, Week 5A 2009 is 
highlighted. 

 Entries on the top bar. 

Select Entry by Event. 

You can enter swimmers by name. 
The process is similar. 

 

 

The top portion of the “Entry by Event” screen displays the meet’s events. 

The bottom part of the screen shows each athlete who is age-eligible to swim the event. The time next to the 
swimmer’s name is his/her season’s best time. 

 

 

In the example, Event 13, Boys 15-18 100 Free is highlighted, and the 15-18 boys on the Omega Team are sorted 
according to their season-best times in the 100 Free. 

1-5.a2  To Enter An Athlete In An Event 

Box to the right of the swimmer’s name in the “Entr’d” column. The row with the swimmer’s name will be 
highlighted in yellow. You may be asked to select a team. If manually seeding the meet, you also should indicate 
the Heat and Lane number for each entry. (Visiting teams have the right to choose “odd” or “even” lanes and this 
choice should be clarified prior to preparing entries. Lane assignments should be made based on the swimmers 
times, with fastest swimmers earning the middle lanes. In a 6 lane pool, teams with odd lane assignments will put 
their fastest swimmer in lane 3, second fastest in lane 5, and third fastest in lane 1. (Even lanes will seed 4,2,6). 
In an 8-lane pool, lane assignments will be 5,3,7,1 and 4,6,2,8. If using automated seeding, you can skip the step 
of assigning heat and lane. 

If swimming multiple heats of events, Heat 1 will be considered the faster heat and should include the swimmers who 
you intend to score in that event. While swimmers in extra heats of freestyle may still score, swimmers entered 
into extra heats of any event other than freestyle (i.e., IM, back, breast and fly) should be marked as “exhibition” 
by putting an “x” in the Exhib column in the row beside the swimmer’s name, unless otherwise agreed upon by 
both teams. 

Click column heading to 
sort athletes by times. Click here for swim-ups. 
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1-5.a3  To Delete An Athlete 

Uncheck the box to the right of the swimmer’s name in the “Entr’d” column.  The yellow highlighting will disappear. 
 

 

1-5.a4  Relay Team Entries 
 

Your team in the 
“Swim for Team” pull- 
down menu towards 
the top center of the 
screen 

   

New Relay.  An “A” Relay entry will be created. 

New Relay again to create a “B” relay entry and again to create a “C” relay entry, if needed. 

If swimmers’ names appear in the box under “Swimmers,” click “Clear Swimmers.” Team Manager will confirm that 
you want to remove each swimmer from the relay. We generally recommend that you prepare relay entries 
without swimmers. Swimmers names can be added during the meet in Meet Manager once coaches have 
confirmed what swimmers will be swimming in the relays. 

 

 

 

 Close to return to the Main Menu. 
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1-6. Print Entry Paperwork (Visiting Team) 
1-6.a1  Meet Entries 

ReportsPerformanceMeet Entries.  Complete “Report Filters” as shown. 
 

 

 

1-6.a2 Rosters 

ReportsAdministrativeAthletes.  Complete “Report Filters” as shown. 
 

 

 

 Verify that entries are correct. 
 Verify that relay teams have been entered into each relay event. 
 Make sure that no one is swimming more than 4 events total with no more than 2 being individual events. 
 If possible, have the coach double-check before you print more copies and make the entry and roster files. 
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 Print at least one copy for your coach. 
 Create a .pdf of the Entries and Roster Reports by creating the report, then clicking on the top left “export” icon. 

Select Adobe Acrobat Reader and save the file appropriately. The .pdfs of the entries and roster should be 
emailed along with the exported entry file created next. 

1-7. Export Entries and Athletes 
Insert Storage device in the appropriate port.(flash drive or disk) 

 File from the Main Menu. Select Export 

Choose “Meet Entries” or “Athletes/Teams.” You cannot export Meet Entries and Athletes/Teams at the same time. 

Select Drive and Folder where you want to store the files.  In the example, the file is being exported to a flash drive. 

Select Meet (or Team) you want to export from the pull down menu. 

 OK.  When the export is finished, the small rectangle appears. 

 OK to close the small rectangle. 

 Close to return to the Main Menu. 

The graphics below show the export operations for entries and rosters. 

 

 

 

 

 

1-8. Exchange Entries 
The visiting team is to email the entries and roster Hy-tek files, along with .pdf or word copies of the entries and 
roster, to the home team by noon the day of the meet, unless other arrangements have been agreed upon by both 
teams. Once meet entries and roster files have been sent to the Home Team, DO NOT make any changes to these 
files. Changes may be made by the coach at the meet. 
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1-9. Setting Up Meet with Meet Manager 
1-9.a1  Restore CCSDA Dual Meet Template (Host Team) 

 
 Obtain the CCSDA Dual Meet Template from the Automation page of the CCSDA website. Do not unzip file 

or attempt to “open.” Another option is to restore a backup of a previous meet then renaming and deleting all 
results. 

 From Meet Manager, click Main Menu → File → Restore 

 For Restore Method, choose “Unzip, copy database to a selected folder and open this new database.” 
Also, choose the “rename database” and name the database according to the meet, 
e.g. 2011-06-21_ArmyNavy@Argyle 

 Browse to CCSDA Dual Meet Template File and click open. 

 Select where you want to save your database (may want to start a folder “2011 Swim Meets” for easy 
identification. 

 Click OK when Message regarding the database you are about to unzip & open appears. 
Meet Manager database will unzip. 

 Click OK again for it to open. 

 

1-9.a2  Finalizing Your Meet Set Up 
Many of the setups for a CCSDA dual meet are already incorporated into this 

template, but you will have to make some changes. 

1. Main Menu → Set-up → Meet Set-up 
Change Meet Name (Away Team@ Home Team), Location of the meet (pool name), Start Date and End 
Date for your Meet (usually the same day) 

2. Main Menu → Set-up → Options → Global 

Set number of lanes for all prelim and finals sessions to reflect number of lanes being used in meet (usually 
6 or 8) 

 

Set Label Preferences 
 

 

Run Screen 

 “Preferences” from the Run Screen 

Select “Award Labels” to reach the “Award 
Preferences in Run…” 

Relay Names should be set to 5. 
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Report Screen 

 Awards from the Main Menu 

 
Select Award   Labels   to   reach   the    “Award 

Labels” screen. 

 

 

 
Set Relay names to 5. 

   

 

Format Award Labels 

Main Menu → Labels → Award Labels 

Make changes to the Label Selection if needed. The template assumes sheets containing 30 labels and awarding 

ribbons down to 6
th 

place for individual ribbons and 3rd place for relay ribbons. The teams should confirm in 
advance to what place ribbons will be awarded and this number should be changed if necessary. 

Select “Participation” to generate an award label for each athlete who swims in the meet. This feature enables 
swimmers who are disqualified to receive a participation ribbon. This option generates both standard award labels 
AND the participation labels in a single step.  Disqualified swimmers are given “NT” on their labels—Not “DQ.” 

If you decide to use this, change “Individual” and “Relay” places as needed. 

 

1-10. Running a Home Meet 
Once meet set up is complete, enter the roster and entries files for all participating team in order to “build” the meet. 

1-10.a1 Importing Entries 

File → Import → Rosters Only (perform for each team’s roster) 
If running a double dual meet (more than 2 teams in a meet): 
Set-Up → Entry/Scoring Preferences → 2 or 3+ double dual → Select Teams → Select All Combined 

 

Assign lanes to teams: 

Set-up → Seeding Preferences → Click and drag teams to appropriate lanes 

Select “strict assignment fastest heat only.” This will allow program to seed events into fewer heats by seeding teams 
with many more swimmers in various events to be placed in adjacent lanes. 

 

1-10.a2 Seeding Meet 

If teams assigned lanes and heats to swimmers while preparing meet entries, skip this step. Otherwise, if allowing 
Meet Manager to seed the meet: 

 

From Main Menu → Seeding → Select All → Start Seeding 
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1-10.a3 Print Meet Program 

From either the Seeding Menu or Main Menu → Reports → Meet Program → Select All to print heat sheets for all the 
events on the list.  The events will be highlighted in yellow. 

“Columns/Format” tab at the bottom of the screen. Select triple column to save paper. 

Select features you want the printout to include, such as records, team scores, etc. : 

 

 

Create Report to see a copy of the Meet Program. Review program to make sure relays have been entered and 
seeded for each team, appropriates swimmers are marked as “exhibition,” and lane assignments are correct. 
Print programs for all coaches to review at Scratch meeting 

. 

1-10.a4 Making Swimmer Adjustments 

This section shows you how to make any changes identified during the Scratch meeting from the Run screen. Do not 
reseed any event. If you have already printed the lane timer sheets and copies of the program for the officials, make 
sure all changes are also made manually onto these documents. 

 

Scratch Swimmer 

In this example, Peanut Butter will be scratched from Lane 1 in Event 7. 

 
 
 

 

 here to add a heat. 
 Run from the Main Menu. 

Highlight 
Event to which you want to make 
changes. 

 “Adjust” to reach “Preview/Adjust.” 
Screen. 

   on the name of athlete to be scratched. 
The pop-up will ask you to confirm that 
you want to scratch the highlighted 
swimmer. 

 Yes or No. 

 “Save” to return to the Run Screen. 

If you need to add a heat, 

 “Add Heat at the top left of the screen. 
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Add Swimmer 

In this example, Monmouth Junction will be added to Lane 2, Event 20. 
 

 Run from the Main Menu. 

Highlight 
Event to which you want to make 
changes. 

 Adjust to reach “Preview/Adjust” 
screen. 

If you are adding a “Swim-Up,” 

 Show Swim-Ups box on the left 
hand column. 

Put Cursor 
in lane where you want to add a 
swimmer. 

to reach “Athlete List” pop-up. 
Scroll down the list until 
Monmouth Junction’s name is 
highlighted. 

 OK. 

 

 

Monmouth Junction is now in Lane 2. 

 Save to return to the Run 
Screen. 

 

 

Move Swimmer 

We recommend that you move swimmers by scratching them first, then adding them to their new heat or lane. 
Although you can move swimmers within an event by dragging and dropping, it’s difficult to keep track because when 
you move a swimmer to a lane occupied by another swimmer, the swimmers switch lanes. 

 
Add a Relay Team 

 “Run” from the Main Menu. 

Highlight Event to which you want to make a change. 

 “Adjust” to reach the “Preview/Adjust” screen. 

 “Show Teams” to see the list of teams in the meet. 

Highlight team you want to enter in the event. 

Drag to correct lane. 

 “Save” to return to the Run screen. 
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The Run screen will include the relay. 

 

Delete a Relay Team 

 “Run” from the Main Menu. 

Highlight Event to which you want to make a change. 

 “Adjust” to reach the “Preview/Adjust” screen. 

 “Show Teams” to see the list of teams in the meet. 

Highlight team you want to delete from the event. 

 A pop-up will ask you to confirm 

 “Save” to return to the Run screen. 
 

Once all changes have been made, make copies of the program for the coaches, officials, clerk of course and team 
reps following the prior instructions. For announcer’s copy, print one in a double column format. (If running short 
on time, print a couple of copies of the meet program, then print lane timer sheets before printing additional meet 
programs.) 

 

1-10.a5 Lane Timer Sheets 

Once you have reviewed the program and appropriate changes and corrections have been made, you can print 
Lane/Timer Sheets to use in place of the pink and blue cards. (If expecting minimal changes, you can print lane timer 
sheets prior to the Scratch meeting and then make any changes manually on to the lane timer sheets.) 

 

From either Seeding Menu or Main Menu → Reports → Lane Timer Sheets 
1. Check box next to events or which you want to print lane/timer sheets or Select All to print lane/timer sheets 
for all the events on the list. 

2. Check boxes for the features you want the printout to include, such as 2 events per page, sorted by lane or 
event. If you choose 2 events of lanes per page for format, sort by Event than Lane and then print 2 lanes at a time 
(Lanes 1 to 2, then print again selecting Lanes 3 to 4, and so on), your lane timer sheets will only needed to be cut in 
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half, with no collating necessary. 
3. Create Report to see a preview. Then Print. 

 

1-10.a6 Entering Results 

The following is one way to set up the responsibilities of the people working the table of the meet. This operation uses 
5 people— SORTER, READER, OPERATOR, VERIFIERS. Jobs can be divided in other ways, but should incorporate 
representatives from all teams competing to ensure “checks and balances.” 

 
Sorter 
1. Accepts timer sheets from runner and DQ slips from Referee, 
2. Staples DQ slips to correct lane sheet and marks “DQ” on the lane timer sheet . Be alert for slow DQ slips. 
3. Circles middle time or checks that right time is circled on each sheet. 
4. Puts sheets into heat/lane order starting with Lane 1. 
5. Hands the sheets to the READER. 

Reader 
1. Starting with Lane 1, READER first calls out the names of the swimmer in Heat 1, Lane 1, followed by the 

swimmer’s time to the computer OPERATOR, followed by Lane 1, Heat 2, etc. until all times for Lane 1 are done, 
then moves to Lane 2, etc. until all times for that event area entered. If there is a different swimmer in the event 
who was not previously entered, or if a swimmer swam in a different lane/heat than previously assigned, 
OPERATOR should be sure to match up the appropriate time with each swimmer’s name. If using manual timing, 
you can follow steps above regarding Scratching or Moving a swimmer or simply just look for the correct name 
and enter the appropriate time. READER and OPERATOR should do a quick sanity check, but recommend that 
other volunteers verify results. 

2. If changes are made to swimmer’s names/lane assignment on the lane timer sheet, READER makes 
OPERATOR aware of these changes. NOTE: Changes made during the meet should be reported to the 
table by the appropriate head coach so that changes can be made in the computer. If you’re unsure that 
changes made on the lane timer sheet are official, please verify with the appropriate team’s coach. 

Operator 
1. Working with the READER, locates names and enters them into MM for each event. 
2. Working with the READER, makes any swimmer changes necessary. 
3. Prints 1 copy of results. Lane timer sheets and results sheet handed to VERIFIERS. 
4. Prints awards labels when appropriate after the VERIFIERS are finished. 

Verifiers 
Verifiers check results.  Two people as a team work well, provided that they move away from the scorers’ table. 
1. The first verifier calls out the time and name (in that order) from the time cards; 

2. The second verifier checks the printed sheet. 

3. If no errors, the printed sheet is posted somewhere away from the scorers’ table. 

4. If corrections are necessary, notify the OPERATOR and verify results once a new sheet has been printed. If no 
corrections are necessary, tell OPERATOR, who can print out a second copy of the results to be stapled to the 
lane timer sheets and can print award labels. 

 

Enter Times 

Run from the Main Menu.  Highlight the event on which you want to work. 

In addition to the mouse, you can use up and down arrows to move among swimmers. To enter the 
results by lane rather than by heat, on the Run screen, check the box at the top of the page that says 
“Enter Results By Lane.” You then can use the arrows to move between lanes of the same events. To 
return to entering results by heat, uncheck the box. 
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In the “Finals Time” column: 

Type each swimmer’s time without colons or periods even if swimmer is disqualified like Minnie Mouse in Lane  1. 

Type NS for ‘No Shows.”  In this example, Starogard in Lane 3 overslept. 

Record disqualifications (DQ) by clicking the DQ checkbox. 

Optional Assign DQ Code: Before you use this feature, check with the Referee and Reps.  These codes 
are not substitutes for DQ cards which contain full explanations of violations. 

Click the DQ Code pull-down menu.  Check the most appropriate code based on the DQ card. 

In this example, Minnie in Lane 1 swam breaststroke on the initial leg of her IM. The code for this violation, “5P 
Strokes out of sequence-IM,” is highlighted in the DQ Code pull-down and inserted into the DQ Code column beside 
Minnie’s name. DQ codes can appear in Meet Results if you’ve selected that option in Report Preferences. 

 

 

Exhibition (Non Scoring) Swims 

To declare a swim as exhibition (non-scoring), check the “Exh” box. Entries prepared by each team should be marked 
exhibition as appropriate before importing into the meet. This includes entries into any extra heats of events swum 
other than extra heats of freestyle (i.e., swimmers in any extra heats swum of IM, back, breast and fly should be 
marked as “Exhibition.” Swimmers in extra heats of freestyle should be allowed to score.) Exhibition swimmers will 
appear with an “X” beside their name on the heat sheet. 

This graphic shows you how to move among heats and events. 
 

 

 to move among heats in single event. 

 to move among events. 



2011 CCSDA Automation Handbook Automating Meets 

17 

 

 

You can also move from one event to another by highlighting the event, on which you want to work, in the “Event List” 
towards the top-left of the Run screen. 

 

1-10.a7 Score Event, Print Results 

 “Score” in the center of the Run screen 
 

 

to see a preview of the Results. The “Report Preferences” set earlier (Section 3-6.a1) ensured that each swimmer’s 
individual points and the team scores appeared on the report shown below. 

 

 

If you see a mistake, 

to close the “Results” preview and return to the Run screen. 

Fix the problem. 

“Score” again to return to the “Results” preview. Anytime you change results, be sure to click “score” or “re- 
score” so that if the change affects the score, it can be updated appropriately 

Printer icon at the top of the “Results” preview to print. 

to close and return to the Run screen. 

 
Scoring of events in a standard CCSDA dual meet should be as follows: 

 
Individual Events – 5 (first), 3 (second) 1 (third) 

 
Relay Events – 8 (first), 4 (second) 2 (third) for Medley Relays 

 
10 (first), 5 (second) 2 (third) for Graduated Freestyle Relays** 
(see information about manual scoring of this event) 

 
Scoring in the Meet Template is already set-up this way. If your scoring is not appearing in this way, from the main 

screen of MM, click on “Set-up” – “Scoring Set-up” – “Standard” 

Under “Individual Points,” type in “5” for Place 1, “3” for Place 2 and “1” for Place 3. Type the 
appropriate points under “Relay Points” also. 
When done, click “OK” 

 
Note that scoring of Events 49 & 50 will need to be adjusted manually at the end of the meet. Instructions for this 

appear in Section1-10a.9 Relay Scoring on page 19. 
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1-10.a8 Print Award Labels 

From the Run Screen’s Awards Box (to print for an individual event only) 

“Awards” box in the middle of the Run Screen 

 

to see a preview.  You can print labels for only a single event from the Awards box in the Run screen. 
 

 

If you see a mistake, 

 in either top right or top left corner to close the “Award Labels” preview and return to the Run screen. 

 Fix the problem. 

 Score to return to the “Award Labels” preview. 

 Printer icon at the top of the “Award Labels” preview to print. 

 to close and return to the Run screen. 

Note that labels print 30 to a page, so try to batch print your labels accordingly. 

Batch Printing From Run Screen or Main Menu 
 

 Labels at the top of the Run screen or from 
Labels on the Main Menu. If you have not set 
up labels, refer to in 4-1c on page 11. 

Check Events you want to print.  They turn yellow. 

 Create Labels at the top of the screen to see a 
preview.  If you see a mistake, “close,” fix 
the problem, and return to the print screen. 

 Printer icon to print. 

 Close to return to previous screen. 

In the example, Events 1 and 2 are checked as already 
printed, and Events 3 and 4 are highlighted to be printed. 
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1-10.a9 Relays 
Coaches should provide names of all relay swimmers to the table prior to the relays taking place, however, 
relay names can be added at any time. Names can be provided through the use of relay cards or just listed 
on a piece of paper. 

“Rel Names:  Ctrl-R” from the Run screen to reach the “Relay Names Screen.” 
 

 

Enter a Relay Swimmer 

Highlight  relay team for which you want to enter or delete swimmers. 

 on swimmer’s name in the “Eligible Athletes” list.  The name will appear in the “Relay Order” box, 
OR 

Drag        swimmer’s name from the  “Eligible Athletes” list to the “Relay Order” box. 
 

Delete a Relay Swimmer 

 on swimmer’s name on the “Relay Order” box. 
 
 

Rearrange Relay Swimmer Order 

Drag & Drop names within the “Relay Order” box until the order is correct. 

 Close to return to the Run screen. 

Relay Scoring 

Hy-tek does not allow for different scoring of relays, so points need to be added manually to the final 2 relay events of 
the meet. Hy-tek will score the event as 8-4-2, which is appropriate for events 25, 26, 27 & 28 (Medley Relays). 
However, events 49 and 50 should be scored 10-5-2. To score the meet appropriately, be sure to manually add 
points to the first two finishers as appropriate, i.e. 2 points to Place 1 and 1 Point to Place 2 for both Events 49 and 
50. If the final score of the meet is not close, it is not necessary to perform this step. 

Athletes entered in 
this relay event 

Age-eligible athletes 

for this relay event 
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1-11. Wrapping Up the Meet 
Once all results have been entered and verified and all award labels have been printed, there are 3 final steps. 

 

1. Provide final score to announcer: A running team score should appear on the right side of the 

Run Screen throughout the meet. After all events have been scored, you can make any manual 
adjustments to the score as necessary from Events 49 and 50 and then provide the final score to 
the announcer. If the Team Scores do not appear on the Run Screen, go to “Reports”→ “Scores” 
→“Select All” →Make sure “Combined” and “Team” and “Combined” are checked→”Create Report” 
to produce a final Team Score Report. 

2. Save Back-up and/or Meet Export copies to a flash drive for each team (steps below). 
3. Save a .pdf copy of the meet results to send to the CCSDA Webmaster (steps below). 

4.  Forward information about any CCSDA records to the Records Chairperson: When a swimmer or 

a relay team sets a new CCSDA league record at a dual meet, Relay Carnival, or Divisionals, the 

host team is responsible for notifying the Records Chairperson, Jean Sylvester. To do so, send 

an email to Jean.Sylvester@verizon.net and include the following information: 

Swimmer’s name, Swimmer’s team, Event Name, Time swum, Date of meet 

1-11.a1 Back-up Database 

All teams will want a Back-up copy and/or a Meet Export copy and should provide a flash drive for you to use for this 
purpose. You also should back up the database onto the computer. 

 

 

 

 

Messages will flash across the screen as the back-up is created. 

Insert flash drive. 

 
 FileBackup from the Main Menu 

to reach the “Backup Current 
Database” screen. 

 
Browse  to drive where you want to save the 

backup file. 

 
 OK. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 OK at the ‘Backup Options” screen. 

NOTE New backups to the same disks do 
not overwrite previous backup files. 
If you backup more than once and 
you need to restore, you must be 
sure that you are restoring the 
most recent version. 
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 OK to return to Main Menu when the back- 
utility screen indicates that the back-up is 
complete. 

 
 

 

 

 

1-11.a2 Export Results 
 

You can put the Export File on the same flash 
drive as you used to backup the database. The 
Export File will be imported into Team Manager. 

 FileExport. 

 “Results for Team Manager ” (first 
choice) to reach the “Export Records” 
screen. 

In the “Export Results screen, 

Uncheck “Include Splits” and “Swim-off 
Events.” 

Select the Team for which you want the results 
exported. 

 OK to reach the  “Export File Progress” 
screen. 

 

 

 

The “Export File Progress” screen will display 
the progress of creating the export. 

 OK when the numbers stop flashing and 
you see “Export Finished“. and Meet 
Manager will ask you where you want to 
copy the results. 
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Browse to a floppy, CD, or flash drive when 
you see the “Meet Results” screen 
to save your file. 

 
 

 

 

 OK when Meet Manager tells you that 
the file has been zipped successfully 
and confirmed the location of your file. 

Make one file for each team. 

   

 

1-11.a3 E-Mail Results to Webmaster 

To make a .pdf copy of the results, Click “Reports”→”Results”→”Select All”→check “Triple Column”→”Create Report” 
Click on icon in the top far left for “Export Report”→Select Format as “Adobe Acrobat (.pdf) and save it to a file you 
can access for emailing. Email the file to rjfox@verizon.net within 24 hours of conclusion of meet. INCLUDE TEAM 
SCORE IN THE E-MAIL SUBJECT LINE OR MESSAGE, e.g., Army-Navy 144 – Argyle 132. 

1-11.a4 Print Complete Meet Results (OPTIONAL) 

To print a hard copy of the complete results, follow these steps. 

 Reports from the Main Menu. 

Select Results to reach the “Results” Screen. 

 Select All.  The events will be highlighted in 
yellow. 

 Tabs at bottom of screen to format the report. 

Setting the columns to “Triple” requires less paper and 
usually prints a little faster. Double Column is a little easier 
on failing eyesight. 

   

 

    

mailto:rjfox@verizon.net
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1-12. Get Ready for Next Meet 
1-12.a1 Import Meet Results into Team Manager 

 

Insert flash drive containing the Export 
Results file. 

 File from the Main Menu. 

Select Import Meet Results 

 

Browse to flash drive containing your file 
when you the “Import Results” 
screen. 

 

 

After selecting the file to import, Team 
Manager will tell that the file you just 
selected has been unzipped. 

 OK to reach the screen containing 
the unzipped file.  

Highlight the unzipped file. 

It now has an *.hy3 extension. 

 on the file, 
OR 

 Open 

to reach the “Import Results” screen and 
select your import criteria. 

 
 

 

 

When this screen opens, this message 

 
will be in the bottom-right corner, and the 
“Import Statistics box will be blank. 

DO NOT 

check “Add New Teams/Athletes.” 

Make sure “Add Relays” is checked. 

Type your team abbreviation to the right of 
the box titled “One Team.” 

 OK to start the import. 

Team Manager will display the progress of 
the import in the “Import Statistics” box. 
When the import finishes, the bottom left- 
corner will read “Import Successful.” 

 Close to return to the Main Menu. 

If you unintentionally import another 
team’s results. Click “Teams” from Team 
Manager’s Main Menu, highlight the team 
you imported by mistake, click “Delete.” 
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1-12.a2 Restore Meet Manager 
 

Insert flash drive that contains the 
meet database created in 
Section 1-11.a1. 

 File 

 Restore to reach the “Restore 
Method” screen. 

 Replace, etc.  (the first 
choice) 

 OK. 

 

 

Highlight The file you want to 
restore. Follow 
instructions confirming 
that you want to 
restore.  You will 
return eventually to the 
Main Menu. 

Highlight The file containing the 
meet database. 

 

 

 OK to confirm that you want to 
restore when you see “Unzip 
and Replace the Currently 
Open Database.” 

 

 

 

 Yes to confirm again. 
 

 

OK to return to Main Menu. 

NOTE 
Subsequent backups do not 
overwrite previous backups. The 
file name changes with each 
backup by adding 01, 02, 03 to the 
end of the file name as shown 
above. 

 

 

 

 

1-13. Records 
You may keep accurate, up-to-date record files easily using Meet Manager and Team Manager. This section shows 
you how to enter, import, export, and use other records.  Meet Manager 3.0 has a new feature that allows you to 
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designate records that only one team may break (i.e., only swimmers from your team can break your team records). 
 

1-13.a1 Creating in Meet Manager 

 Events from the Main Menu.  Select “Records” at the top of the screen. 

 in the bottom-left corner to reach “Add Record Tag Name” (e.g., “Omega Pool Records,” “Omega Team 

Records” or “CCSDA League Records.” 

Fill In as follows. 
 

Order The order in which you want 
the record to appear on meet 
programs and results reports 

Tag 
Name The name of the record 

Flag Symbol next to record 

breaker’s name 

Record 
Only For Designates records that only 

one team may break. In this 
example, the Omega Team is 
highlighted so that Meet 
Manager will not flag Delta 
Force swimmers who achieve 
times faster than Omega 
records 

 

 

 

 
When you are finished, the box will 
look like this. Only Omega 
swimmers can break Omega 
records, but anyone can break 
CCSDA records. 

 

 

Type your records information like a 
spreadsheet. 

 

 
Make sure that you set the Gender, 
Age Range, etc. as shown. 

   

 

CCSDA record information can be found on the league website, countryclubswimanddive.org, if you wish to include 
these records on your program. 

 

1-13.a2 Editing and Updating 

 Events from the Main Menu. 

Select Records. 

To edit record-holder names, times, dates, or teams, make changes like a spreadsheet. 

The following table shows how to change the name of a team record, its symbol, display order, or to 

restrict team record breakers to their own teams. 
 

To restrict record-breakers, 

Highlight team name 

 pull-down menu in the “Team Only” column. 

Highlight team to which the record will be restricted. 

 

Change the Flag symbol by typing change in the box to the right of 

the tag name. 
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To change “Order” or “Tag Name,” 

Highlight name of record file you want to change. 

 to reach “Edit Record Tag Name.” 

Type Changes 

 OK to save. 

 
 

 

 

     

1-13.a3 Importing 
 

 Events from the Main Menu. 

Select Records. 

 Import. 

Browse to the file location. 

Select file with the records to import. 

 Open. 

 OK.  You cannot make any changes 
here in the Select New Tag box. 

The records should appear on the list. If not, 
uncheck “Show Records-Selected Tag Only” in the 
bottom right corner. 

Once you have imported records, you can make 
changes.  See “Editing and Updating.” 

  

 

 

 

1-13.a4 Exporting 
 

 Events from the Main Menu. 

Select Records. 

Highlight Record to be exported in the bottom-left 
corner. In this example, the Omega 
Team Record is highlighted. 

 Export in the top-left corner. 

 Yes on the “Create a Records File” pop- 
up screen. 

Browse to the file location where you want to 
store the file and save it. 

 
 

 

 

    
 


